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Welcome to Password Repository 

The True Native Password Manager for Mac

Password Repository  is a Cocoa native application to keep secure all the 
passwords a user has to manage.
Passwords are saved on disk always inside encrypted documents.

In case your Macintosh or your document files are accessed by unauthorized 
persons, these persons will not be able in any way to read all the data inside your 
Password Repository  documents.

These let your store your most important informations, such as credit card data, 
bank account access and so on in a safe way.

Password Repository  is a standard macOS document based application.
You can manage as many documents you like, all with different data inside and 
anyone protected by a single master password of your choice.

In case you need to use Password Repository  as a ‘utility’ application just to 
manage a single set of passwords, you can specify in the preference to have a 
specific document automatically opened at startup. In that way you will avoid to 
open it manually every time you launch Password Repository , even if now, it is a lot 
more easy then before thanks to the auto-resume feature of macOS.

We made our best to keep Password Repository  powerful and simply, as any true 
MacOS application has to be.
We are proud of the work we made with this new major release 3 and we hope you 
will like it.

Password Repository for iOS documents and Password Repository for 
macOS documents can be created and used both on Mac and on iOS devices. 
Documents are totally interchangeable over the platforms. You can move 
documents from one platform to the other without any problems.
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Getting Started with Password Repository 
Startup actions

At launch Password Repository  opens by default an “Untitled” empty window.
It can also display a file browser to select a file to open
or open your preferred document at startup, depending of the preference settings.

You can change the preference settings according with your needs.

Opening a New Document

Opening a New Document will present a request to introduce a Master Password to 
protect the document
This is the password used to encrypt all the content of the document
You must use a password you can remember (or write it in a safe place)

It is very important you remember this Master Password. Without it you won’t be 
able to access the content of this document next time you will open it.

It is required to enter the Master Password  two times to avoid input errors.
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Window Organization 

Password Repository  uses a Master and Details view.
It organizes the passwords in the window using a 'master' table on the left where 
you have a view of all your data and a 'details'  right section  to see the selected 
element in detail.
The table is separated by the details part by a vertical split.
You can resize the 2 views them using the split
If you resize the detail over the minimum size it will be hided
You can use the Hide/show details icon in the toolbar or at the window bottom to 
show it back

When you resize the window both parts are resized proportionally
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Adding Data

Add a row in the table data using the “Add” button inside the toolbar or from the 
menu.

Every row in the ‘master’ left part of the window represents a record in the list of 
your data.
Adding a new row switches the 'details' of the data in the bottom part of the window 
to the 'Edit' mode to let you insert new data.

You can always switch from the ‘Edit’ to the 'View' mode. 

The view mode is useful when you are just browsing your data and want to avoid 
unintentional changes.

Edit Data

Password Repository  User Guide  © 2005-2022 Ecleti - Roberto Panetta page 5



You can think at the “View - Edit” button as e double status button, keep "Edit" 
enabled if you are adding or editing your data. 
Switch to the view mode, if you are browsing your data, to prevent unwanted 
changes.

Categories

Categories are a way to keep all your passwords organized. 
Any record is associated to a 'category' that explain the 'kind' of password it contains

First of all you need to create some categories. 
To create categories use the ‘Categories…’ command

Create some new categories assigning them meaningful names and distinctive 
colors
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Use colors to better recognize and distinguish them.

You can at any moment create and delete categories using the 'Categories' sheet. 
Categories in use (with one or more notes associated) can't be deleted.
To delete a category in use you must assign to all the notes using it another 
category

View Data 

You can order the row by any field clicking the header in the table, and with a click in 
the little arrow in the header you can change the sort order (ascending or 
descending).
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You can also search the displayed rows to the one containing a specific string. Just 
type the string on the search field on the upper-right corner of the window and as 
you type, only the matching field are displayed.
To come back to a full display of the rows, click the cross inside the search field to 
set a null search string.
Regarding the password field inside the table, you have the option to show its 
content in clear text or as secure text (dot bullet).
Use the "Show Password in Table" under the ‘Tools’ menu to show all them in the 
table.
Use this  option if you have only trusted people able to watch at your screen on that 
moment.

Save Data

Password Repository uses automatic saving as any good standard modern MacOS  
app.
For your safety, Password Repository  doesn't allow you to save data in plain 
format.
If you saved it with Password Repository , you can be sure you saved it encrypted.

This is the reason you can always be sure your data are safe, even if your computer 
is stolen (except you made the stupid error of letting the one who took your 
computer to know your Master Password)

Open Data
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Close your document.
Now, we will try to re-open from disk the document you previously saved.
Use the “Open” command from the “File” menu.
Password Repository  will read the file from disk and will display you a window with 
the request of the password to open it.

The data in your file were saved encrypted and for now they still are just a bunch of 
bit totally useless. Even an hacker with various tools won't be able to do anything 
with them.

To really open the document, it is necessary to decrypt them and yes,
it is necessary to use the Master Password, specified for the document.

Try different password, even the same password with a letter case changed, as an 
example “Myhouse” instead of “myhouse”, and it won't work.

Type the right Master Password and Password Repository  will open it almost 
instantly even if the process is quite intensive because today, even a low end Mac, 
is a very powerful machine from a computational point of view.

Passwords

Just a warning, if you are not just experimenting and you are already working on 
your data, when you decide the Master Password, write it down or be sure to 
remember it.
The encryption algorithm used by Password Repository  it’s not a toy, it is a serious 
one, very strong and secure. If you will not be able to type again, exactly the right 
Master Password you wont be able to access your data.
Even we, the developer of Password Repository, will not be able to open your data.
There is nothing to do.
There are no backdoors or other things.

No password, no data. Period.
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You are warned, choose a right password and keep your password in a secure 
place.
See the Password Strategies section of this user guide to learn a bit about that.

These are general rules you will find useful in your life if you deal with computer and 
password and you have no an idea about password strategies.
This should be enough to start working with Password Repository .
See the References  part to learn more about all the functions available in 
Password Repository .
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Password strategies

Don’t Use the Wrong Master Password

Tension software did its best to let normal Mac users use Password Repository  in 
the best way,simply and secure.

We mean, when we say "normal Mac users", people which don't have to be 
information technology expert.

Unfortunately as every security tools, also Password Repository  requires, to be 
used, a minimum of knowledge.

It’s like driving a car. If you don’t have a minimum idea on how it works, don’t blame 
the constructor if you go to crash somewhere driving like a total idiot.

For the use of Password Repository , it’s important  to select a right Master 
Password to protect your document.
If the Master Password for a document is weak, all your passwords inside the 
document  can be compromised.

Remember that the persons trying to access your data, know perfectly the errors 
that dumb users make using this kind of software, so they will try all the tricks within 
the first few seconds of their first attempt to break inside your data, just to see if you 
really are a total idiot ...

A password, to be safe, must be unrelated to things other knows about you (the 
owner of the password), any hacker will try to guess your password using things and 
persons related to you, even investigating a bit about you.

(as example, if you are a mom, knowing the name of your child often reveals also 
the password you used ... and I suppose you already know that).

Don't use name of your relatives or name of places or things or persons or ideas 
everyone knows are strongly related to you, a skilled person will try these words as 
soon as it will get his hands on your documents.

Don't underestimate his capacity to collect information regarding you, specially if he 
was able to put his hands on your computer.

The best part of this is that usually the persons who chose these passwords, when 
someone was able to find them and break in, says: “How he did it?”

Wrong question. The correct question should be “Why I was so idiot?”

Another well know, more complex technique, is to try all the name in the dictionary, 
using automatic software tool, that can try thousands of words per second and 
letting them run for days.

The direct consequence, is to use for a password, words NOT in the dictionary, or 
add odd character as an example “suit#case” instead of “suitcase”
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In Password Repository , you can use also pass phrase as Master Password, so 
you can use: “my 5 red suitcase” or better “my 5 red suit#case”, instead of 
“suitcase”.

Another common mistake: using the same password in more then one place.
Don't use a password you used in one environment to protect another environment, 
the administrator of the first environment can read that password, why let him 
access the other environments?
The rule is: a different password for every place.
So use for Master Password a password never used before.

Don't use the “Show" option to show the Master Password in clear text when you 
type the password to protect the document unless you are secure that no one or 
only really trusted people are looking at your screen.
Don't always use the "Show" option to show in clear text the passwords inside a 
document.
 
Use it only if  trusted people, or no one at all, are looking at your screen.

Be Paranoiac (just a bit)

And to be a little paranoiac remember that trusted people today can be your enemy 
tomorrow (strong security requires a paranoiac attitude)
To remember passwords use technique used by people who impress the others 
remembering long list of data, use emotional images to remember a complete 
phrase.

You know yourself, you know how to impress your mind.

In any case don't trust your memory too much, SAVE your Master Password and 
don’t save it on your Mac near your Password Repository  document.
You can see that we avoided to say to use secure Master Password such as 
"slertd7js 09usdnvwof53 ndfretlu " yes, this should be a perfect Master Password 
but… who can remember it?

We know you need a Master Password you can remember and we know that you 
can forget it, specially if you don't use it for a bit.
Now, if Password Repository  helps you in the work of remembering all your 
passwords, it can't help you to remember the Master Password to open your own 
document.

If you loose the Master Password to open the document containing all your 
passwords ... it can be a little trouble.
We can't help you in this circumstance. Really.
 
The suggestion is to save the Master Password on paper and to store it away from 
your computer.
If you change the Master Password remember to update the one written on the 
paper!

Now You Know
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This few informations should let you be able to choose a good Master Password 
and manage it properly. So a brief list:

DON’T

1) Don’t use names related to you that people know
2) Don’t use true common names
3) Never, never, never use for Master Password a password you used elsewhere
4) Remember that the one that can try to access your document can use the 

involuntary help of someone that knows you very well.
5) Don’t attach a post-it near your computer with your Master Password.
6) Don’t let others know your Master Password. Be pragmatic about your Master 

Password. It’s a very private thing, not something to share with friends, even 
trusted ones.

7) Don’t think an idiot will try to access your data. When it will happen, a very smart 
person, not an idiot, will try to access your data.

7) Don’t forget your Master Password. Have a way to be able to have it even if 
something odd occurs.

8) Don’t ask us to help you open your document without your Master Password. We 
have no way to do it. No way. Seriously.

DO

1) Use no sense words or use true words intermixed with numbers and symbols that 
only you can remember. Don’t use names of facts of your life the others can know 
or guess.

2) keep your Master Password in a safe place, if possible a physical place different 
from where your computer is located
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Reference

Window Organizations

The main Password Repository window has two main parts:

The left part has a table, with every row consisting of a separate record with different 
fields, also called the 'master' part.
These fields contain specific entries such as name to distinguish the record, url, 
account name or login used, password, and a field for various note. You can 
navigate and select the table using both the mouse or the cursor.

The right part of the window has fields to view and edit in details every field of the 
record selected in the upper part. If enabled you can navigate the fields also using 
the keyboard. This part is often referred as the 'Details' part.
You can resize the two parts using the split zone between the two zones

When you have more than one window opened, it can be useful to manage them 
with the Window” menu,. It hold a list of all the opened windows and provide 
additional command such as “Zoom”, “Minimize” and “Bring All to Front

At the very bottom of the window, the bottom bar has useful frequently accessed 
command buttons to copy data of the current selected record in the clipboard.
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Toolbar

In the upper part of the window, the toolbar allow fast selection of frequently used 
commands.

You can change the layout of the toolbar in the way you do it in any other Cocoa 
application, just right-click in the toolbar, or ctrl-click (with single button mouse) and 
select from the popup menu "Customize Toolbar..."

Password Repository at launch

When launched, Password Repository  can:
- opens the previously opened document via the standard resume behavior
- opens a new window or 
- display an open dialog or 
- opens your preferred document as you choose in the preference panel. 

You can set the preferences according with your needs using the preference dialog.

New Document

Opening a new document, Password Repository will ask for a Master Password to 
protect the document.

Insert a safe Master Password and be sure you can remember it. 
Please read the Password Strategy section about that.
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Adding Data

When a document window is open, to add data you have many choices:

Pressing the “Add” button from the toolbar

Selecting the add button at the bottom of the table

Selecting the “Add Row” command from the “Edit” menu or using the keyboard 
equivalent command-key

After that a new row is added with “Untitled” in the name field and the other field 
empty.
Is up to you fill in with your value and assign the right category from the popup. If 
your data requires a new category create it and assign it via the popup.

You can add data also importing it from an external text file, see Import.

Editing Data

You can use the fields in the bottom part of the window, to edit data of the selected 
row in the table.

The fields in the detail area can be switched from the state( View/Edit) to allow 
changing and inserting data when necessary and to avoid unwanted changes of the 
value when you are just browsing the data.
To switch from View to Edit use the button in the toolbar or at the bottom of the 
details part.
When switching from Edit to View the appearance of the fields change to help you 
recognize the switch.
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Browsing the data is the most used features after you have inserted your data and 
the "View" non editable state is to avoid unintentional change of your data if you just 
need to view them.

Using the category popup inside the edit area you can at any moment assign a 
different category to the current selected record.
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Editing the fields allow to change any data inside

A special note is for the password field, it is a secure text field which shows a series 
of bullets when you type the text, to avoid that someone looking at your monitor can 
see your passwords. 

You can click the “Show” button near the password field to switch to a clear text 
mode for the password field.
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At that point consider that other people near you can read and take note of your 
passwords.

Another button allow to copy the content of the password field in the clipboard 
allowing to copy and paste in other applications without have to enable the editing of 
the field of having to show the password in clear text.

You can delete a row in many ways:
• By selecting it and choosing “Delete Row ” from the toolbar

• Selecting ‘Delete Row’ from the menu command
• Selecting the ‘Delete Row’ button from the bottom of the table list

A confirmation is always required to delete a row from your data.

After that, if you realized it was a mistake , you can undo your action and have back 
the record you deleted.

Browsing and Searching Data

Password Repository  allows to view data directly in the table and selecting a row in 
the table it will display data in details in the fields under the table.
You can change the selected row in the table, using the up and down arrow of the 
keyboard, when the table is selected.
The table offer another great feature, very useful when the data inside the table are 
large, you can sort the data simply with a click in the head of every column of the 
table.
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To reverse the sort order just click the small arrow inside the selected column to 
invert it and reverse the sort order.

You can also move and adjust the width of the columns in the table using the 
mouse. Experiment with the mouse inside the table, it is totally interactive. 

Two great tools available inside Password Repository  are the search field and the 
categories popup in the toolbar. 

In the search field just type a string and automatically as-you-type the table shows 
only rows with the inserted string in any field, if a row has not at least a field with the 
string typed in the search field, the row will not be shown.

Think at it as the command “Show only the rows that contains … ”
Using the categories popup is even more easy. Just select a category and only the 
records with the same category will be displayed.
You can combine both the search using the search field and the categories popup, 
only the records matching both two request will be shown.
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When the table is showing only some of the rows in the document, you can perform 
on these rows all the usual action.

At the top of the window an optional area will appear and show how many records 
match the search:

Same indication is showed also at the bottom of the table.

To switch back to the “Show All Rows” condition, just click the cross in the search 
field or make empty the content inside the search field or ‘Select all’ from the 
category menu or click the ‘Show All’ button.
 
Search command and show category works as you type and click, after  typing or 
clicking a popup, you don't need to issue a search command, the table show the 
matching rows as you type in the search field.

At any moment you can press Option-Command-F to activate and start type in the 
field in the toolbar.

You can save the search you made within the popup in the search field
To save it after you inserted a search text, press return inside the search field.

At any time you can recall a search selecting it from the popup.
You can also clear all the saved search in the popup from the menu
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All the saved search fields are retained over application relaunches.

Use Your Data

When you browse and find the data you need, you want also to use them
Password Repository provides some help to make it in a better a fast way.

In the detail area you can copy in your clipboard anything with a simple click on the 
label of a field

When you click on the label or icon of a field, note that the label changes to ‘Copy’ to 
show you that you are coping the content of the field to your clipboard

To copy to your clipboard data, you can also use the pulldown menu at the bottom of 
the detail area

When you copy a value pressing the label on the left of the field, you can also 
receive a visual feedback via a popup hud that persist on the screen a short time.
You can personalize that in the preferences
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You can also open with your default browser the Url inside the url field, clicking in 
the ‘Open Url’ icon at the right of the Url field.

To show your password, PINnand security text,in plain text (and not in dot) press the 
‘Show Password Icon’ at the right of the password field.

A special case is when you have to perform a task that is very common with your 
data:
•Select the record you need
•then select a ‘User ID’
•then Open a web page
•then paste the ‘User ID’ in a field
•then copy a ‘Password’
•then paste the ‘Password’ in a field

We provide a fast method without using plugin and method using additional tools
We call it  Push&Pull

Push and Pull

Push&Pull let you perform the most common task regarding password use on 
internet: entering your ‘User ID’ and ‘Password’ in a web site in a fast and elegant 
way.

To launch it, simply select in Password Repository   the record you need, then press 
Push&Pull from the toolbar

Password Repository  User Guide  © 2005-2022 Ecleti - Roberto Panetta page 23



or in the Push&Pull button from the detail area

Push &Pull will operate on the selected record opening the Url and pushing your 
‘User ID’ in the clipboard
So you can insert your ‘User ID’ in your default browser that automatically will open 
your page.

Now you need to insert your password.

Do you need now to go back to Password Repository  to copy your ‘Password’?
The answer is: NO

Look with your browser active and frontmost, at the menu bar on the right:
a new icon was just added.
It’s the Push&Pull icon, and you can access it also from your browser.
It’s the one on the left of the status group (the last added to the one you have in 
your status part of the right of the menu bar).

It’s the one depicting a key entering in a circle 

Still in your browser, you click it, and the password is copied in your clipboard.
You paste it.

Notice that the Push&Pull key disappeared after that from the menu bar. 

We think this new Push&Pull method is simple and absolutely secure, without 
plugins or any other additional tool to use inside your browser.

You ‘Push’ and the app copies the ‘User ID’ and opens the web page at the ‘Url’. 
Then you ‘Pull’ and it copies the ‘Password’ from the status bar.
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or ... you can see in another philosophical  and conceptual way:

The app copies the ‘User ID’ and opens the web page at ‘Url’ and it pushes the 
‘Password’ inside the icon in the status bar, when you click the Push&Pull icon, you 
pull the ‘Password’ out of the icon in the menu bar to your clipboard

It works.
Simply, secure and elegant.

If you press the information mark button at the bottom of the detail area you can 
have a panel remembering you how Push&Pull works.

 

Categories

Categories are a useful way to keep all your password organized. Any record has a 
'category' name that explain the 'kind' of password you are storing
Categories, using different colors, give to your data a fast way to understand at what 
you are looking with a single glance.
First of all you need to create some categories.

Access the Category Editor form the 'Edit' menu or from the toolbar and add and 
rename some categories as you need.
You can assign to each category a different label and text color. This let you use the 
different categories to immediately recognize the type of password looking at your 
main window.

At any time you can change the name and colors used by a category
Changing a category, changes all the records using it
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As example changing the background color of a category changes the color of the 
label of all the records using the category, while you change it in the wheel color.
In that way you can see live the result.

In the category panel, any category has on the right the number of records using it.
It is not possible to delete a category if a record is using it.
To delete a category used by some records, go back to the main view and assign to 
the records using the category another one.

Emails

The Emails panel allows you to enter a list of emails you own.
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In that way when you are asked in various place on the net, to give your email to 
register, you can insert in Password Repository  the email used from a popup ready 
to use containing all the emails you have in the list.

This popup is available only when in edit mode and is enabled only when the email 
field is empty, to avoid overwrite an email you already inserted.
In case you need to change the inserted email you have to delete the previously 
inserted one.

 

To have the emails popup appear the field must be empty

Open Generic Url

If you insert in the Url field the url of a WEB site, when you click the 'Open' button 
near the field, it will be opened in your preferred browser. You can use drag&drop 
from the internet client to the 'Drag&Drop' area between the Url field and the 'Open' 
button to drop a Web Url in Password Repository 
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If you insert in the Url field the url of a FTP site, when you click the 'Open' button 
near the field, it will be opened in your preferred ftp client AND, if you inserted also a 
user id and the right password, they will be used by the client to login in the ftp site, 
no typing required.

If you insert a file url, of a file on your hard disk,  in the Url field, clicking the 'Open' 
button will show the file in the desktop.
It is not possible to launch it anymore due to sandbox restriction.

You can use drag&drop from the finder to the 'Drag&Drop' area between the Url field 
and the 'Open' button

Create a New Password

Inside the app, is provided an utility to create good quality passwords.
You can invoke it from the ‘Tools’ menu using the ‘Create Password’ command
Then select the type and the length of the password

To copy the created password in the clipboard click the ‘Copy’ button.

Table Customization

On Password Repository  you can customize the main table.
The popup menu at the bottom of the window allows to select which column to 
display.
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You can turn on or off any column visualization, plus you can use predefined set
In the predefined set CMA stays for: Created Date, Modified Date and Accessed 
Time (number of time you accessed a record)

You can customize the table as you like.

You can also hide the details view

The document remembers your previous setting when you re-open it.

You can turn on/off the dot password visualization in the table (if you want to see the 
passwords too)
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You can also save a specified column set using the command ‘Set Current as 
Custom’ in the popup menu.

To recall it simply reselect the ‘Custom’ command  from the bottom popup menu. 

Save Data

To save a document select the 'Save' command from the 'File' menu:

The document will be saved encrypted using the master password you inserted.
Note that every successive save operation will be performed without the need to 
insert the Master Password again, Password Repository  will remember the Master 
Password you inserted and will use it for the document, but it will NEVER saved 
inside the document.

Every document is associated with one Master Password, if you have more than 
one document opened and you inserted a Master Password for one of them, this 
Master Password will not be used by other documents and you have to specify it for 
every new document you want to save.
Is up to you to choose to use the same Master Password for every document or a 
different one for each document.
Password Repository  will ask it for every document just one time only. 

After that, any document will remember its Master Password for the current session.

You will need to use the Master Password again in a document, only if you want to 
change the master password (for security purpose) or if you closed it and you want 
to re-open it.

Password Repository  remembers also the position, the size of your window and the 
single width of every column of the table. This let you, opening a document, to work 
with the correct size and columns width from the start.

Open Data

To open a Password Repository  document:

select “Open” from the “File” menu.
A standard MacOS dialog will let you select the file to open.
After that the document will need to be decrypted using the Master Password used 
for it.

Without the right Master Password, the document can’t be opened because data 
inside are encrypted, not just because the document has a lock. 
There is not the possibility to understand and present the data inside the document 
in a readable form even using others software or specialized tools. 
The Master Password is not stored inside the document, NEVER. 
If you provide the wrong Master Password, the program understand it is wrong just 
because the decryption session signals an error.

Password Repository  doesn't know the right Master Password until you insert it. 
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The document can't be read using tricks. If there is not the Master Password, there 
is no way to decrypt the data inside the document, even for us, the creator of the 
software. Remember it. No Password No data.

There are NO backdoors in the software, we have no interest to place them, and we 
acts honestly with our customers, so with Password Repository  our customers get a 
tool that is based on the power of mathematical algorithm, because this is 
guaranties of effectiveness.

You are warned, losing or forgetting the Master Password used to save a file with 
Password Repository  is equal to lost the entire data inside the document and we 
can't help you in this unfortunate circumstance.
See the ‘Password Strategies’ section of this help to learn a bit about a correct 
Master Password.
In that section you will find general rules you will find useful in your life if you deal 
with computer and password and you have no idea about password strategies.

iOS password sharing

Password Repository  has an iOS version too.
It’s available inside the iTunes store. Look for ‘Password Repository 4’
It works for iPhone, iPod Touch and iPad

The iOS version of Password Repository is powerful as the desktop version (almost)
It can read and write, create and modify all the Password Repository document.

It is multi document (as a true app, not a toy) with multiple documents, any with it’s 
own password, uses AES-256 as the desktop version with the same level of security 
and ... it is fast and sexy!
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To exchange data with Password Repository for iOS lyou can drag and drop files 
from one device to another directly from the finder

• Connect your Device to your Mac
• Open the finder and select your device in the finder
•

• In the bottom part (file sharing) Password Repository will be listed and you have 
the Shared files area

•

• Drag and Drop there the files you want to share
• It works both to and from your devices

Now if you launch Password repository for iOS on your iOS device (iPhone or iPad) 
you will see all the documents you copied,  listed inside Password Repository for 
iOS.
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Select it, insert the correct Master Password you used on Mac on that document 
and you are ready to work with it on iOS.

You can do the opposite too. Transfer files from iOS to MacOS.
It works without any problems too.

You can exchange a Password Repository document and share data with iOS as 
you would do from your desktop Mac and your MacBook.

Data Import

To import data inside a Password Repository  document from other sources:
Select the “Import from Text File” command from the “File” menu.
An Open File dialog will let you select a file (it must be a text file ending in ‘.txt’ or 
‘.text’ or .cvs’ or ‘.tsv’).

You can also select the encoding file format, or use the AutoDetect format.

You can select the data format (tab separated value, comma separated value 
or char separated value using semicolon) or use the AutoDetect feature also 
here.
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Select the file to import and confirm. 
Password Repository  will scan the file and will present a successive dialog to adapt 
the operation exactly to the file you are importing
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.

You can browse one by one the record you are importing from, to see the content of 
the file you are importing using the Previous and Next buttons arrows.

On the right side, using the popup menus you can decide where the data goes to, 
during importing.
When you have set up all the fields you want to import from and the target fields 
where you like to import to, press the ‘Import button’. 
All the records will be imported inside the document.
You can avoid to import the first record if it was used for field headers.

The import operation can be performed only to opened document, so if you want to 
create a new document with the content of a text file, first create a new document 
then use the “Import from Text File” command.

Remember:
The file to import from, must be a text file in CSV (comma separated value) or in 
TSV (tab separated value) or CSV-S (char separated value using semicolon). 
The tex file have to end with “.txt” or with “.text”  or “.csv” or “.tsv”
Otherwise it won't be displayed by the “Choose a File” dialog. 
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You can use the ‘AutoDetect’ option to let the application select the right import 
algorithm  to use

Password Repository  can handle automatically text document encoded for MacOS, 
Mac OS Classic, Unix, Linux, DOS, Windows.

The order used for the fields in the file you need to import it is not important because 
you can customize using the import dialog, what and where to import.

Data Export

You can select to export all the data inside the document or only the one filtered out 
using the search field.

To export the filtered records select “Export to Text File” from the “File” menu.
or
To export All the  records select “Export All to Text File” from the “File” menu.

Password Repository  will present a standard file dialog to define which fields to 
export and in which specific order:

After that you will be asked to select a destination where to save and the format.
You can choose between:

Password Repository  User Guide  © 2005-2022 Ecleti - Roberto Panetta page 36



• Tab Separated Value
• Comma Separated Value with Quotes
• Comma Separated Value no Quotes
• HTML Table
• Full page in HTML containing a table
• Custom format where you can specify the separator you like

Custom where you can insert the tags you want to use to generate a data export

Exported file will be always encoded in the default MacOS format UTF-8

Master Password

Understanding how password are used is fundamental step for using Password 
Repository  in the best way.

First of all understand that every saved document is associated with a Master 
Password.
The document needs the Master Password before it can be saved on disk.
The password protecting the document is called Master Password to distinguish it 
from the one inside the document representing your data.

The document can't be saved for security purpose in plain format (we assume that if 
you are using Password Repository  you are going to save reserved data). So there 
is no way to save your data in a format others can read (except you save it 
exporting it as text data for transportation purpose to other applications) using the 
‘Export to text file’ under the ‘File’ menu. 

If you never specify a Master Password for a document, at saving time Master 
Password will ask you a master password before saving, this to prevent someone to 
save data unprotected.
If you are working with a document and you didn't set a password for it yet, you can 
do it using the Master Password command from the 'File' menu or from the Toolbar.

The panel will ask you to insert the Master Password two times just to be sure you 
are inserting the password you want to.
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Inserting a different Master Password of what you think, and don't see it because 
you are using the secure text field which display dot instead of letter as you type, it 
is similar to don't know the Master Password used, with tragic consequence for the 
data in the document (you won't be able to access the document in future).
If you have a document with a Master Password already set, you can at any time 
change it using the Master Password command from the 'File' menu or from the 
toolbar.
To change it you must provide the old Master Password and insert and confirm the 
new one.

If you have written down the Master Password in a secure place (as an example on 
a paper) , if you change your master password, remember to update it, or when you 
will go to read it you will read the old one, and when you will try to open the 
document with the old Master Password you have changed ... you understand it, 
also smart people sometime do silly things.
Note that the Master Password is case sensitive, so “myhome” and “Myhome” are 
different password 

Please check that the caps lock of your keyboard is not inserted when you digit the 
password (unless you really want it) because if you think you have inserted 
“myhome” and you inserted “MYHOME” as long as you will try to open the 
document with “myhome” you will get a wrong password alert that can drive you 
crazy.
We reported this specific case because we noticed that is a common error by users. 
We also noticed at that point that people try to insert the same wrong password a 
zillion of time hoping the computer will accept it. 
...We inform you that if the Master Password  is wrong, Password Repository  won't 
accept it, even if you try a zillion of time.

To help you avoid trouble, we added inside the password panel, a “Show” password 
button.

If you are not in an environment where someone untrusted can look at your monitor 
you can disable the secure text field and see in clear text the password you type.

Change Master Password

To change the Master Password inside an opened and decrypted document, you 
can use the ‘Master Password...’ command under the file menu.
You need to insert the old Master password and confirm 2 times the new one.

Encryption

Encryption is the fundamental part of Password Repository .
Without encryption, Password Repository  would be an insecure tool. 
It will not give you a guaranties that your precious data won't be accessible by other 
people.

Consider this: you use an online bank account, or PayPal, or have your credit card 
number with pin stored, or your eBay account on your computer and your computer 
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(maybe a portable Mac) is stolen or maybe it just won’t work and you sent it for 
assistance to an assistance center. 

Yes, they do not have the password to enter your login but data on the hard disk are 
plain data, they just have to mount your computer's Hard Disk  on another machine 
and all the data inside it are accessible. 

Any power user (or less, it is needed just a bit of skill) can do that. 
Suddenly all your data are in the wrong hands (specially if they don’t obtained your 
computer in an legal way, we assume it is not in good hands).

If you have used Password Repository  and you have used a good master password   
they can do nothing with your data, because they are encrypted with a strong 
AES-256 algorithm (Previous version used Blowfish) and without the password your 
data are just a useless series of bit. 

I can't say it is impossible to decrypt them, but the effort necessary to break 
AES-256 in the way Password Repository  uses it, it is really too much for them.

Password Repository  doesn't allow to save a document without a Master Password, 
this to force data to be always encrypted and ask for a password of a minimum of 6 
character to force you to use a password which has a minimum of security.
This is what Password Repository  can do. It would be possible also to let the 
software choose the password for you but unfortunately you need a password you 
can remember, so you need to think yourself at the password to use.

Unfortunately very often this is a cause of big pain because people doing this don't 
realize they are disabling the scope of encryption, which is making not possible for 
other understanding the data saved.

This is the reason we dedicated on this help a page on that.
 
Please, please, read the Password Strategies section, probably you already know 
about that, but if you don't know it, you must read it, not only to use Password 
Repository  but just if you deal in your life, in any way, with passwords.

Dark and Light Appearance Mode

Password Repository is fully compatible with Dark Appearance Mode and Light 
Appearance Mode on any macOS release it can run on.
You can switch at any time from one mode to another
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Preferences

General

Specify the action to do at startup:

• Standard Behavior (with auto-resume)
• Open Dialog if No resume
• Open Dialog Always
• Open Selected preferred document

At any successive relaunch Password Repository  will execute the option selected.
The additional two buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch
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To select a document press the select from disk button and select it from the open 
dialog that will follow

At any successive relaunch Password Repository  will execute the option selected.
The additional 3 buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch
• Delete the bookmark reference to the file (you will need to reselect a file)

The reference to the file is taken using scooped bookmarks and they work even if 
you move the file on your disk, even if your file is in the trash.
To update the path display in case the file was moved,  click the ‘show in finder’ or 
the ‘test open’ button

Font

Let you specify font and format for the table list (master part of the window)

Password Create

This let you specify chars to avoid to use in password creation (if you use that option 
to allows Password Repository to create passwords when you need a new one)

Usually chars like the number ‘0’ and the char ‘O’ and the number ‘1’ and the char ‘I’ 
and other that are very similar or totally similar to avoid confusion in using it.
You can use the default suggested one or use your own set.

Timing

Let you specify:

The autolock  background time interval.

The application, when in background, after a period of inactivity automatically goes 
in lock mode after a specified time interval
Master password must be re-entered to access the data.
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This is a security feature to help you avoid to forget you have Password Repository 
in background opened and with all your passwords exposed to anyone that can 
access your computer if you leave it for a while.

The auto recovery delay 
In case of crash the document can recuperate the unsaved data thanks to a parallel 
file the document maintains without user actions. This setting specify the delay 
interval to save in the parallel document.
To recuperate the data user has to do nothing. 
Password Repository  do it all just relaunching the application after a crash.

The Push&Pull icon removal delay
When using Push&Pull the icon placed in the menu bar, used to ‘Pull’ the password 
is automatically removed from the menu bar if you don’t use it, for safety reason,  
after a time interval you can set here.

Advanced

Let you specify:

To have an Hud popup informing you when a copy operation to the clipboard of a 
value was successful

You can define also how long the Hud will persist on screen
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You can define also the sort type to use for columns when you click in the table 
header

Software Update

* Update section is not available in the App Store Release (if you purchased 
via the App Store, to obtain an update use the App Store Update function) 

Password Repository  can inform you if an update is available.
We suggest to keep this option enabled to be notified about update.
We trimmed this option over time to be non-intrusive.
When connecting with our Tension Software server  it does NOT send any 
information, it just ask for availability of upgrades. 

In an update is available, the application will ask you if you like to download an 
upgrade.

If you download the upgrade, you need to install it.
A common error is to download an upgrade and install it maintaining the old 
application somewhere on the hard disk.
Then using to open the documents sometime the old application and sometime the 
new one. This cause some problems*. To avoid it simply install your application in 
the place dedicated to it, the Application folder. When you install an update on the 
standard Application folder, the system will ask if you want to replace the old one 
with the new, answering yes will install the new one replacing the old.

*If the application says the document you are trying to open was created with a newer 
version of the application, probably you have two different release of the application on your 
Hard Disk and you are trying to open a document with the older version after having 
modified the document with the new one. When you receive a similar message open the 
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about box inside the application and see if you are running the latest release. In case 
download it, install it and USE it!

Help

Password Repository  provides a PDF User Guide help menu.

Under the help menu use the ‘Web Site’ to access our site a download the very 
latest release of Password Repository  and other software for Mac we make.

Support

You can also obtain support using the ‘Email Support…’ command. 
An email will be prepared using your email client with the correct address to send to.
Yes, we answer to your emails.

About Tension Software and Ecleti

All the software asset by Tension Software is now under Ecleti 
New company name but still the same owner and main developer (Roberto Panetta)
So for the users nothing changes. We provide the same software and the services. 
All the user licenses are valid and assistance is provided as before to all our users.
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